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Digital Infrared Photography

• What is infrared photography?

• What equipment do I need?

• How do I photograph?

• What do I photograph?

• When can I photograph?

• How do I process my image files?

• Where can I find additional information?



The electromagnetic spectrum

1 nm (nanometer) is 1/billionth of a meter 10-9 m

1 µm (micron)        is 1/millionth of a meter 10-6 m

1000 nm = 1 µm 



The electromagnetic spectrum
Near, middle, and far infrared

• IR photography uses near infrared

• Many astronomy images are made with mid infrared light

• Heat is far infrared

http://gallery.spitzer.caltech.edu/Imagegallery



The Egg Nebula

In visible light In near infrared



Sources of IR radiation

• Sunlight

Direct sunlight is:

47 %  infrared

46 %  visible

6 %  ultra-violet

• Tungsten lamps

• Electronic flash

The spectral output for tungsten lamps

The spectral output of the Nikon SB140 flash
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IR photography history

Film Digital

Kodak HIE film; B+W 093 filter Converted Nikon D70S camera; 

R72 filter



IR photography history

Film

• Need to bracket widely 
and can not see results 
until the film was 
developed

• Images are black and 
white, so there is no need 
to be concerned about 
the white balance

Digital

• Can see results 
immediately and adjust 
exposure and focus in 
real time

• May get “false colors” or 
red, depending on the 
white balance setting



Equipment

• Cameras and Sensors

• Filters

 IR cutoff filter (and the anti-
aliasing filter)

 IR passing filters

• Lenses

Canterbury Shaker Village, NH



Spectral sensitivity

• This is a spectral sensitivity graph 

for a standard photographic CCD 

sensor

• The visible spectrum uses only 

60% of the CCD’s sensitivity

• Ultraviolet and infrared light use 

the other 40%

The common silicon detectors are sensitive to ~ 1,100 nm 

This is what makes digital cameras perfect for IR photography



The Bayer filter mosaic

The Bayer arrangement of color filters 

on the pixel array of an image sensor.

A 2 x 2 pattern is used to determine 

color.

Typical photosensors detect 

light intensity. 

A mosaic of tiny color filters is 

placed over the pixel sensors.

Notice there are twice as many 

green filters.



IR cutoff filter

When a camera is converted, the top 

NIR blocking filter is removed and a 

visible light blocking filter is placed on 

the sensor.



IR cutoff filter

• With most lenses, infrared 

radiation will focus differently than 

visible light

• An IR blocking filter is placed on 

the sensor in order to create a 

sharp image

• This type of filter is sometimes 

called a “hot mirror”

• This filter is removed in 

converted digital cameras

The spectral sensitivity curve of 

the typical IR blocking filter



Anti-aliasing filter

Digital SLRs have an anti-aliasing (AA) filter to prevent 

Moiré patterns

• Also called a “blur filter” or a “low pass” filter

• Usually sandwiched with the IR cutoff filter

• Vary in strength 

• Work by making the image a bit fuzzy

 A black pixel next to a white pixel will result in two gray pixels 

 A blue pixel next to a red pixel will result in blurred purple pixels 

• Is removed with the IR cutoff filter in converted cameras

 Images may be sharper



IR passing filters

Two commonly used IR passing filters:

• The Hoya R72  (B+W 092; Wratten 
89B)

 Is dark purple, almost black, in color

 Passes some visible red light

 50% cut-off at 720 nm

• The B+W 093 (Wratten 87C)

 Totally opaque

 Cuts out all visible light

 Get stronger IR effect

 50% cut-off at 850 nm

For non-converted cameras, use the 
R72 since the blocking filter in the 
camera may cut off too much of IR; 
as a result the 093 filter may be too 
strong

Filter Comparison
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IR passing filters



IR passing filters

Images from www.Lifepixel.com

• Enhanced filter

• Standard filter

• Deep Infrared filter



IR passing filters

Filter Type Range Effect

Enhanced Color 665 to 1300 nm •Includes more visible light, which results in a 

greater range of color

•Image has a lower contrast

•Harder to get a crisp B&W image

Standard Infrared 720 to 1300 nm •Includes some color information

•Normal B&W image with good contrast

Deep Infrared 830 to 1300 nm •Blocks all color information

•Produces high contrast B&W images



Cameras

Unconverted camera

• Can your camera detect IR 

radiation?

• To test this, point a TV remote 

directly at your camera and take a 

picture of it while pressing any 

button on the remote

• Older cameras work better for IR 

photography

• Newer cameras have stronger IR 

blocking capabilities

Converted camera

• The IR blocking filter on the sensor 

has been removed

• The anti-aliasing filter (sandwiched 

with the IR blocking filter) is also 

removed 

• The blocking filter has been replaced 

with one passing mostly or only 

infrared (you choose), OR with glass

• Adjust the camera focusing 

mechanism

• Create a custom white balance

• Camera can now be used only for IR 

photography



Cameras

Unconverted camera

• Need to use IR filters and a tripod

• Hoya R72 for false colors; B+W 

093 for IR only (monochrome)

• Use the camera’s meter reading 

as a starting point, and adjust 

accordingly

• Long exposure times from tens of 

seconds to ~ 1 minute, hence the 

need for a tripod

• Foliage is blurred from wind

• Cover the viewfinder during 

exposure

Converted camera

• There are many different flavors of 
converted DSLRs: the filter used 
as the replacement can be any 
version of an IR filter

• IR passing filter (blocks visual 
light) is on the sensor, not the 
lens. You can compose and focus 
naturally

• DSLRs use different sensors, and 

not the image sensor, for AF, AE, 

and AWB

• These sensors still see visible light 

in converted cameras

• Adjustments will be needed



Lens hot spots

• Lenses are designed for visible light, 

not IR light

• Some lenses have “hot spots”

• They are brighter areas in the center 

of the frame 

• Are internal reflections within the 

optical pathway

• Coatings on lenses create hot spots 

and flare more easily in IR

• More prominent on bright sunny days

• Again, older equipment better for IR

• Use the lens hood

• Can sometimes burn them in with 

Photoshop

Rock Meadow Conservation Area, Belmont

(Nikon 17-55mm f2.8 G lens)



Lens hot spots

Nikon 17-55mm f2.8 G lens

1/125   f/14 -.7ev

Nikon 17-55mm f2.8 G lens

1/250   f/11 0ev

Smaller apertures (larger f/ number) can introduce hot spots



Lens hot spots

CANON LENSES NIKON LENSES

16-35mm 2.8 24-70mm 2.8

16-35mm 2.8 II 35mm 1.8

20-35mm 2.8 24-85mm AF-S 3.5-4.5G 

ED VR

28-70mm 2.8

24-70mm 2.8 II

LifePixel recommends these lenses should be avoided.
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How to photograph
Converted cameras

• Compose your picture while looking through the viewfinder 

• Take a meter reading 

• Bracket your exposures by .3 or .7 ev and verify using the histogram

• You can also use a 093 filter, (in addition to the conversion), to block 

out the visible light that the R72 allows to pass, but you will not get 

the false colors

• Shooting in visible light is no longer possible

• Normal viewing is possible, using visible light



How to photograph
Unconverted cameras

IR passing filters are dark red to opaque

• Place the camera on a tripod

• With the filter off, compose and focus 

• Take a picture and adjust settings accordingly

• Place the filter on the lens

Ex. Hoya R72 for false colors; B+W 093 for IR only (monochrome)

• Use the camera’s meter reading as a starting point, and adjust 

accordingly

• Take many shots, bracketing widely until correct exposure attained

• Exposures will be long because the filters are dark.  Cover the 

viewfinder during exposure



Issues

• Custom white balance

• Focus

• Exposure

These issues differ between 
unconverted cameras and 
converted cameras; and also 
between non-DSLRs and 
DSLRs



Custom white balance

If you don’t white balance - you will get a red image

• Check your camera to see if you can create a custom white balance preset

• Since foliage reflects IR light, making it the brightest, whitest part of your 

photo, you’ll need to “calibrate” your camera to let it know that visible light 

green is equal to infrared white

• Create a preset custom white balance:

Shoot grass full frame in full sunlight (around -1 EV to -2 EV) 

and use that image to set the white balance



Custom white balance preset

• There are some issues with setting a custom 

white balance preset for the following Nikon 

(converted) cameras:

Nikon D40, D40x, D80, D200 

• Visit the Life Pixel and Photo.net web sites for 

additional information about these cameras



Focus



Focus

For converted DSLRs

• Even though the sensor has been converted to pass only 
IR, the autofocus system still uses visible light!

• Focus cannot be completely adjusted because:

1) Different IR wavelengths

2) Different lens focal lengths (for zoom lenses) 

3) The ratio of infrared light to visible light

all influence where the focus point is



Focus

IR does not focus on the same 

plane as visible light

• Back focusing is an issue

• Back focus is when the camera actually 

focuses on something behind the intended 

subject

• Older lenses have a red dot to indicate 

where to focus IR

• This location may be different for the wide 

angle and telephoto ends of a zoom lens



Focus

Newer lenses often do not have 
the red dot, so what do we do?

• Focus on the important part of the scene that is 
closest to the camera

• Use a greater depth of field to counteract focus 
issues

 Use f/8 or smaller aperture to minimize 
focus issues

 Don’t stop down too far! Diffraction is 
twice as bad with IR waves as it is with 
visible light! 

• Focus bracket, especially in diffuse light, and 
for close subjects

• If your camera has Live View, use that to focus.

Autofocus

Manually focused closer



Exposure

• The meter sees visible light, not IR

• DSLRs do not use the image sensor for light metering

• Bracket, bracket, bracket …

• Anywhere from +1.0 EV  to  -1.0 EV from the camera’s 
meter reading give good results

• After a while you can “feel” when to go over or under 

0 ev



Exposure

If you see cyan areas in the 

image, the green and 

blue channels are fully 

saturated

Cut back on the exposure

Nikon Capture NX2 can 

recover some of the data
Myopia Hunt Club Road, South Hamilton, MA



Digital Infrared Photography

• What is infrared photography?

• What equipment do I need?

• How do I photograph?

• What do I photograph?

• When can I photograph?

• How do I process my image files?

• Where can I find additional information?



The usual suspects – in bright sunlight

• Foliage in sunlight appears white

 Willow trees give the best white 
tone

 Deciduous trees are white also

 Conifers give the darkest tone

• Clouds are clearly defined

• Blue sky appears black

• Water can appear black

• Buildings, roads, and other man-
made structures often appear black 
unless they are in direct sunlight



Sunny day





Rockport, MA

Essex, MA



Foliage

Public Garden, Boston, MA



Foliage

• The air spaces in leaves (not the chlorophyll) reflect IR

• In spring the air spaces are expanding as the leaves mature

• Full size occurs in summer

Spring Summer

Newport, RIBoston Public Garden, Boston, MA



Sky and water

Ebenezer Burnham’s Shipbuilding Loft, Essex, MA



Reflections

Pontiac Mills, Warwick, RI



Clouds

Boston



A cloudy damp afternoon

Belmont Country Club, Belmont, MA



In the rain

Boston Public Garden, Boston, MA



In fog

Prospect Hill Park, Waltham, MA



In fog

Color camera Infrared camera



In snow

Black and white from color image Black and white from infrared image

Cape Ann Golf Course, Essex, MA



Interiors

Andrea’s Flat



Incandescent lights

Rockport, MA



The ordinary

Rockport, MA



The ordinary

Sailing on the Charles River, Boston, MA



The ordinary

Tracks along the Charles River, Boston, MA



Digital Infrared Photography

• What is infrared photography?

• What equipment do I need?

• How do I photograph?

• What do I photograph?

• When can I photograph?

• How do I process my image files?

• Where can I find additional information?



• The amount of IR radiation from the sun is 
highest at noon (solar noon, not daylight 
saving’s time)

• The proportion of IR radiation to light is 
highest just after dawn and just before 
sunset

During the course of the day



During the course of the day

Comparison spectrum of blue sky to red 

sunset
The Chemical Educator

http://chemeducator.org/sbibs/samples/spapers/34samplejg.htm

Daylight is a very rich but unpredictable 

source of infrared radiation which 

changes its spectral qualities with 

changes in the time of day and 

atmospheric conditions

The blue curve shows the spectral 

distribution at noon, the red curve 

demonstrates the shift to red and 

infrared towards dusk 

Medical and Scientific Photography

http://msp.rmit.edu.au/Article_03/02a.html
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Post-Processing

• False colors
• Raw converter software

• Channel swap

• Converting to black and white



False Colors

Essex, MA Plum Island, MA



False colors

• IR has no color

• Your image may display false 

colors

• These colors are the product of 

the camera’s hardware and 

firmware

• Need portion of the visible red 

spectrum (~ 720nm) for false color

• If you use an opaque filter or have 

your camera modified to IR only 

wavelengths (beyond ~ 750 nm) 

you may not get the false colors

Rockport, MA

Essex, MA



False colors

Red line  red channel Green line  green channel Blue line  blue channel

• Before ~ 850 nm you 

are more likely to see 

false colors 

• After ~ 850 nm the RGB 

channels have about the 

same sensitivity, so you 

are more likely to see 

B+W images

• Your specific sensor 

may vary



False colors

A  1/60    f/10    -0.7 ev

B  1/80    f/10    -1.0 ev

C  1/100  f/10    -1.3 ev

A B

C



Raw converter software

To preserve the false color, you need a raw converter to do a linear 
conversion

• White balance application

The raw converter software must be able to apply the custom white 
balance

• Demosaicing

CCD/CMOS sensors only record one color for each pixel and the 
real color for a given pixel has to be interpolated from the 
surrounding pixels

Demosaicing is the process of converting Bayer raw  images, which 
have one color per pixel, to standard images, which have three 
colors per pixel. In the process of demosaicing, missing detail for 
each channel is inferred from detail in other channels.



Raw converter software

The Nikon and Canon raw converters 

will preserve the false colors

• Nikon:   Nikon Capture and ViewNX

• Canon:  Digital Photo Professional (DPP)

Other raw converters

• Adobe Camera Raw

• BreezeBrowser

• Capture One DSLR

• DCRaw

• GIMP

• Microsoft RAW Image Thumbnailer and 

Viewer

and many more

City Square Park, Charlestown, MA



Raw converter software

In RAW mode the camera is not doing any non-
linear processing. All non-linear processing is 
done in the RAW converter.

The image will appear very dark because it has a 
gamma value of 1.0 from the camera and has 
not been adjusted to a gamma of 2.2 normally 
used for displaying images on a PC screen.

Camera profiles and tone curves need to be 
applied later (non-linear conversion).



Raw converter software
Nikon Capture

Original raw file in camera (i.e., the linear file)

Raw file opened in Nikon Capture, auto contrast 

applied, saved as tif, sent to CS3 …

… file opened in CS3



↓

Nikon D70S converted by Life Pixel. R72 filter applied. Custom white balance on a bright sunny day



Raw converter software
Adobe Camera Raw

Original raw file in camera (i.e., the linear file)



Nikon D70S converted by Life Pixel. R72 filter applied. Custom white balance on a bright sunny day



Raw converter software
Adobe Camera Raw (and Photoshop CS3)

Nikon D70S converted by Life Pixel. R72 filter applied. Custom white balance on a bright sunny day

↓Original raw file in the camera

Original file with levels applied in Nikon Capture

Original raw file opened in Adobe Camera Raw

and auto exposure applied …

… then opened in PS CS3 and levels applied



↓



Channel swap

Original images After channel swap 





You can swap channels to make the sky look like the more natural blue color



Channel swap

Set  Red  Blue and               Set  Blue  Red



Converting to black and white

Destructive Non-Destructive 

Luminosity • Grayscale 

• Desaturate

• Lab Lightness 

• Gorman-Holbert 

• Gradient Map 

• Calculations

Color Altering • Channel separation • Hue/Saturation 

• Channel Mixer 

• B+W Adjustment Layer

Destructive methods convert the image by destroying the color information. Once destroyed, the color information 
cannot be recovered

Non-destructive methods convert the image by adding new layers to the existing image 

Luminosity based methods assign a shade of gray based only on the color’s brightness or luminosity 

Color Altering methods alter the colors in the photograph before converting it to grayscale 

For more information:  http://www.blackandwhitedigital.com



Converting to black and white

These are some of the most obvious ways to convert an image from color to 
black and white:

• Image → Mode → Grayscale 

• Image → Adjustments → Desaturate 

• Image → Adjustments → Hue/Saturation → Saturation -100 

• Layer  → New Adjustment Layer → Hue/Saturation → Saturation -100

All of these commands produce, in varying ways, a monochrome image based 
on Photoshop’s assumed ratio between the Red, Green and Blue channels

Photoshop will take 30% of the Red channel, 59% of the Green channel and 
11% of the Blue channel and combine them to create a monochrome 
image

There are other techniques that give you more control



Converting to black and white
Gradient Map

After Gradient MapOriginal false colors

Boston Public Garden, Boston, MA



Converting to black and white
Nik Silver Efex Pro

Adobe PS plug-in tool to create 

black and white images

Can emulate the traditional B+W 

films, toners, and filters

Neutral

High Structure



Converting to black and white
Nik Silver Efex Pro

Same file – different effects
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Camera conversions
• Life Pixel: http://www.lifepixel.com/

• LDP LLC: http://www.maxmax.com/

• Precision Camera: http://www.precisioncamera.com/infrared-conversion-
services.html

• Spencer’s Camera and Photo: http://www.spencerscamera.com/

Canterbury Shaker Village, NH North Avenue, Wakefield, MA



More information about digital IR

• “Infrared Photography with a Digital Camera”

http://www.wrotniak.net/photo/infrared/index.html

• “Introduction to Digital Infrared Photography”
http://diglloyd.com/articles/Infrared/infrared-main.html

• Apogee Photo Magazine, “Digital Infrared Photography Made Easy”

http://www.apogeephoto.com/may2003/odell52003.shtml

• “Digital Photography for What It’s Worth” 

http://dpfwiw.com/index.htm

• “A Gentle Introduction to Digital Infrared Photography”
http://www.infraredphoto.eu/Site/Welcome.html

http://www.wrotniak.net/photo/infrared/index.html
http://diglloyd.com/articles/Infrared/infrared-main.html
http://www.apogeephoto.com/may2003/odell52003.shtml
http://dpfwiw.com/index.htm
http://www.infraredphoto.eu/Site/Welcome.html


Thanks!

Parlee Farm, Tyngsboro, MA



Questions?

How does near infrared relate to the 4th law of thermodynamics?


